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What is HTML File Mapper?

HTML File Mapper is an html file management program that aids in the management of information 
resources for pages on the Internets World Wide Web.    For a quick introduction to the HTML File Mapper
program, try A Brief Tutorial.

The HTML File Mapper program can be a significant aid in managing Web page projects, especially if a 
project is large, involving numerous links to other Web resources, such as html files, graphic images, and 
URLs.    For large projects, it is important to maintain documentation about which html files link to which 
resources, where the links occur, etc.    This information is of particular value when updates to Web pages
are needed.    The program can be used to insure that all required files are included in the updating 
process.

Basically, HTML File Mapper scans an html file (referred to as the Source Document) for references to 
other html files, graphic images, and URLs.    The resources included in the scan are determined by user 
option.    Also available as a user option is the ability to scan not only the original source document but 
also all other html documents linked by the source document.    This provides for a complete mapping of 
all resources referenced in the entire Web page project.

Note that HTML File Mapper operates at the local level.    It does not function as an on-line program to 
map resources while the user is logged into the World Wide Web.    Also note that HTML File Mapper is a 
Windows environment program.

HTML File Mapper is distributed on a shareware basis.    You are granted a license to use this program for
a specific period of time.    Please read the license agreement contained in this documentation.    For 
information about the advantages of and the procedure for registering your use of the program, see How 
To Register.



License Agreement

This software is provided in two version, a registered version and an unregistered version.    Your license 
to use the software is dependent upon which of the two versions you are using.    The license agreement 
for each version is specified below.    Your use of this software indicates your acceptance of the 
corresponding license agreement.

You can tell which of the two versions you are using in any of three ways:

1.    If you are using the unregistered version, <unregistered> will appear in the title bar of the main 
window immediately following the name of the program.    The registered version will display the 
program name only in the title bar.

2.    If you are using the unregistered version, a menu option Register will appear in the menu bar of 
the main window.    The registered version will not have this menu option available.

3.    The Help...About menu option will display an About... window that will show a frame that will say 
Un-Registered if you are using the unregistered version, or will show the name, company, and 
registration ID of the registered user if you are using the registered version.

Unregistered Version

You are licensed to use unregistered copies of this software for a period of 30 days without charge.    
Continued use of the software beyond the initial 30 day limit requires that you obtain a copy of the 
registered version of the software.    The unregistered version may be copied and distributed to other 
users free of charge, provided that neither the program nor any of its associated files are altered in any 
way, and provided that no fee is charged for the distributed copies.

Registered Version

You are licensed to single-copy use of this software.    This means that you can install your registered 
version of the software on one computer at your work or office, one computer at home, and one portable 
or laptop computer, provided that only one copy is in use by the registered user at any one time.    You 
may make copies of the registered version of the software for normal backup purposes.    You also agree 
not to make any copies of the registered version of the software for distribution to other users.



Disclaimer

Sonshine Computing Services and Richard A. Eckhart (proprietor), hereafter referred to as vendor, accept
no responsibility for damages caused by this program, and they, either together or individually, make NO 
WARRANTY, either express or implied, with respect to the performance or merchantability of this 
software.    The software is provided on an AS IS basis, and you, the user, assume the entire risk when 
you use it.    Any liability of vendor shall be limited exclusively to product replacement or refund of the 
registration fee, at the option of vendor.



Using the Menu

File

New Clears the specifications to start a new set
Open... Opens an existing user file of specifications
Save Saves the current specifications in the current user file
Save As... Saves the current specifications in a new user file
Source Document... Opens a dialog box to select the source file
Print... Opens a dialog box to select an text file to print
Exit Exits the HTML File Mapper program

Report Displays the results of the html file mapping

View Displays the mapping results on the monitor
Print Prints the mapping results on the printer
File... Writes the mapping results to a file

Map Performs the html file mapping according to the given specifications

Options Lets you choose the html file mapping options

Map All Linked Documents Maps the source document and all linked documents
Map Anchor Elements <A> Maps all anchor <A> elements in the html documents
Map Image Elements <IMG> Maps all image <IMG> elements in the html documents

Register Opens a window to register your use of this program.
This menu option is only available in the unregistered version of the program.

Help

Contents... Opens the Help system Table of Contents
Search For Help On... Searches the Help system for a topic
How To Use Help Tells how to use the Help system
About... Tells about the HTML File Mapper program



File...New

Clears the mapping specifications to enter a new set.    The current user file name is also cleared and 
shown in the Title Bar as <untitled>.    To open an existing user specification file, use the File...Open menu
option.

To quickly clear the specifications, click the New button on the Toolbar.

      New button



File...Open...

Opens an existing user specification file.    This menu selection opens a dialog box that lets you select the 
user specification file you want to open.    The path and name of the opened file are displayed in the title 
bar of the main window.

To quickly open a user specification file, click the Open button on the Toolbar.

      Open button

Dialog Box Options

File Name
Select or type the name of the user file you want to open.    By default, this box lists files with the filename 
extension, .USR.    To see a list of files with a particular extension, type an asterisk (*), a period, and the 
three-character extension, and then press ENTER.    To see files with more than one filename extension, 
type a semicolon (;), a second asterisk (*), a period, and another three-character extension.    For 
example, if you want to see all files with the .USR extension and all files with the .TXT extension, type 
*.usr;*.txt.

List Files Of Type
Select the type of file you want to see in the File Name list.

User Files (*.USR)
Lists all files in the current directory that were saved with the .USR extension.    This is the default.

Directories
Select the directory that contains the file you want to open.

Drives
Select the drive that contains the file you want to open.

Read Only
Opens a file as read-only.    To save changes you make to a read-only file, use the Save As... command to
save it with a new name.

OK Button
To open the selected file, click the OK button.

Cancel Button
To cancel your selections, click the Cancel button.



File...Save

Saves the current mapping specifications to the current user file name, which is displayed in the title bar 
of the main window.    The current contents of the user file will be over-written with the current 
specifications and the original specifications will be lost.

If the current user file name displayed in the title bar of the main window is <untitled>, the Save As... 
dialog box will open where you can specify the user file name to save the specification data.

To quickly save the specifications, click the Save button on the Toolbar.

      Save button



File...Save As...

Saves the current mapping specifications to a new user file name. A dialog box opens which lets you 
select the user specification file you want to save.    The new path and name selected for the user file are 
displayed in the title bar of the main window.

Dialog Box Options

File Name
Select or type the name of the user file you want to save.    By default, this box lists files with the filename 
extension .USR.    To see a list of files with a particular extension, type an asterisk (*), a period, and the 
three-character extension, and then press ENTER.    To see files with more than one filename extension, 
type a semicolon (;), a second asterisk (*), a period, and another three-character extension.    For 
example, if you want to see all files with the .USR extension and all files with the .TXT extension, type 
*.usr;*.txt.

Save File As Type
Select the type of file you want to see in the File Name list.

User File (*.USR)
Lists all files in the current directory that were saved with the .USR extension.    This is the default.

Directories
Select the directory where you want the file to be saved.

Drives
Select the drive where you want the file to be saved.

Read Only
Saves a file as read-only

OK Button
To save the selected file, click the OK button.

Cancel Button
To cancel your selections, click the Cancel button.



File...Source Document...

Use this menu option to select the starting or source file to be mapped.    This file must be an html file 
saved as an ASCII/Text formatted file.    It can have any file name extension.    The default extension 
is .HTM.

Selecting this menu option displays a standard dialog box from which you can select the drive, directory, 
and file name for the source file.

Dialog Box Options

File Name
Select or type the name of the user file you want to select.    By default, this box lists files with the 
filename extension .HTM.    To see a list of files with a particular extension, type an asterisk (*), a period, 
and the three-character extension, and then press ENTER.    To see files with more than one filename 
extension, type a semicolon (;), a second asterisk (*), a period, and another three-character extension.    
For example, if you want to see all files with the .HTM extension and all files with the .TXT extension, type
*.htm;*.txt.

List Files Of Type
Select the type of file you want to see in the File Name list.

HTML Files (*.HTM)
Lists all files in the current directory that were saved with the .HTM extension.    This is the default.

All Files (*.*)
Lists all files in the current directory.

Directories
Select the directory that contains the file you want to use.

Drives
Select the drive that contains the file you want to use.

OK Button
To use the selected file, click the OK button.

Cancel Button
To cancel your selections, click the Cancel button.



File...Print...

Use this menu option to specify/select an ASCII/Text-formatted file to be printed.    It can have any file 
name extension.

Selecting this menu option displays a dialog box from which you can specify the drive, directory, and file 
name for the file to print.

Dialog Box Options

File Name
Select or type the name of the file you want to print.    By default, this box lists files with the filename 
extension .HTM.    To see a list of files with a particular extension, type an asterisk (*), a period, and the 
three-character extension, and then press ENTER.    To see files with more than one filename extension, 
type a semicolon (;), a second asterisk (*), a period, and another three-character extension.    For 
example, if you want to see all files with the .HTM extension and all files with the .TXT extension, type 
*.htm;*.txt.

List Files Of Type
Select the type of file you want to see in the File Name list.

HTML Files (*.HTM)
Lists all files in the current directory that were saved with the .HTM extension.    This is the default.

Report Files (*.RPT)
Lists all files in the current directory that were saved with the .RPT extension.

User Files (*.USR)
Lists all files in the current directory that were saved with the .USR extension.

All Files (*.*)
Lists all files in the current directory.

Directories
Select the directory where you want the file to be saved.

Drives
Select the drive where you want the file to be saved.

OK Button
To save the selected file, click the OK button.

Cancel Button
To cancel your selections, click the Cancel button.



File...Exit

Terminates the HTML File Mapper program and returns to the Windows environment.



Using the Toolbar

The Toolbar has the following buttons for quick access to the corresponding functions:

      New        Quickly clears the specifications.    This button has the same functionality as the File...New 
menu combination.

      Open        Quickly opens a user file of specifications.    This button has the same functionality as the 
File...Open menu combination.

      Save        Quickly saves the specifications in a user file.    This button has the same functionality as 
the File...Save menu combination.

      View        Quickly displays the mapping results on the monitor.    This button has the same 
functionality as the Report...View menu combination.

      Print        Quickly prints the mapping results on the printer.    This button has the same functionality 
as the Report...Print menu combination.

      File        Quickly saves the mapping results to a file.    This button has the same functionality as the 
Report...File... menu combination.



Report

Use this menu option to review the results of the html file mapping.    This option is disabled until a Map 
operation is completed.    Then it becomes active with the following three options:

View Displays the mapping results on the monitor

Print Prints the mapping results on the printer

File... Writes the mapping results to a file

To see an example of a mapping report, click here.



Report Example

Following is an example of a mapping report generated by HTML File Mapper.    This report can be 
reproduced by selecting the SAMPLE.USR file provided with this software.

                                                                HTML File Mapper
                                                                          Report
                                                                      06-20-1996

                                                        Source File: SAMPLE_A.HTM

Mapping Options:
        [X] Map All Linked Documents
        [X] Map Anchor Elements <A>
        [X] Map Image elements <IMG>

*** Local Files Mapped ***
S:\HTML_MAP\DEVELOP\SAMPLE_A.HTM (3)
S:\HTML_MAP\DEVELOP\sample_b.htm (3)
S:\HTML_MAP\DEVELOP\sample_c.htm (4)
S:\HTML_MAP\DEVELOP\sample_d.htm (3)

*** Image Files Linked ***
S:\HTML_MAP\DEVELOP\sonshine.jpg (3)

*** URL's Linked ***
mailto:72425.525@compuserve.com (3)

*** Report Listing ***
Source: S:\HTML_MAP\DEVELOP\SAMPLE_A.HTM
            <IMG>        : sonshine.jpg
            <A>            : sample_b.htm
            <A>            : sample_c.htm
            <A>            : sample_d.htm
            <A>            : sample_c.hTm
            <A>            : mailto:72425.525@compuserve.com

        Linked-Source: sample_b.htm
            <IMG>        : sonshine.jpg
            <A>            : sample_c.htm
            <A>            : sample_d.htm
            <A>            : sample_a.htm

        Linked-Source: sample_c.htm
            <A>            : sample_b.htm
            <A>            : sample_d.htm
            <A>            : sample_a.htm
            <A>            : mailto:72425.525@compuserve.com

        Linked-Source: sample_d.htm
            <IMG>        : sonshine.jpg
            <A>            : sample_b.htm
            <A>            : sample_c.htm



            <A>            : sample_a.htm
            <A>            : mailto:72425.525@compuserve.com



Report...View

Displays the html file mapping results in a box on the monitor.    If the report is too long to fit inside the 
box, scroll buttons will appear on the side of the box so that the report can be scrolled up or down to view 
the entire report.

The length of the report will depend on the mapping options you have chosen as well as the number of 
items that have been found during the mapping operation.

To quickly display the mapping report, click the View button on the Toolbar.

      View button



Report...Print

Prints the html file mapping results the printer.    Make sure your printer is turned on and has a supply of 
paper before selecting this option.

The length of the report will depend on the mapping options you have chosen as well as the number of 
items that have been found during the mapping operation.

To quickly print the mapping report, click the Print button on the Toolbar.

      Print button



Report...File...

Saves the html file mapping results to a file.

The length of the report will depend on the mapping options you have chosen as well as the number of 
items that have been found during the mapping operation.

Selecting this menu option displays a dialog box from which you can specify the drive, directory, and file 
name for the report file.

Dialog Box Options

File Name
Select or type the name of the html file you want to create.    By default, this box lists files with the 
filename extension .RPT.    To see a list of files with a particular extension, type an asterisk (*), a period, 
and the three-character extension, and then press ENTER.    To see files with more than one filename 
extension, type a semicolon (;), a second asterisk (*), a period, and another three-character extension.    
For example, if you want to see all files with the .RPT extension and all files with the .TXT extension, type 
*.rpt;*.txt.

List Files Of Type
Select the type of file you want to see in the File Name list.

Report (*.RPT)
Lists all files in the current directory that were saved with the .RPT extension.

All Files (*.*)
Lists all files in the current directory.

Directories
Select the directory where you want the file to be saved.

Drives
Select the drive where you want the file to be saved.

OK Button
To save the selected file, click the OK button.

Cancel Button
To cancel your selections, click the Cancel button.

To quickly save the mapping report to a file, click the File button on the Toolbar.

      File button



Map

After you have made your mapping specifications by selecting the desired Mapping Options and selecting
the Source Document, click on this menu option to run the program and make the html file mapping.

When you select this option, a window titled Working... will be opened in which will be displayed the name
of the html document currently being processed.    This will allow you to follow the progress of the 
mapping operation.

The mapping operation will proceed based on the specifications you have made.    When the mapping is 
concluded, the Report menu item will become enabled so that you can View the report on the monitor, 
Print the report on the printer, or save the report to a File.



Options

You may select the mapping options in either of two ways:

1.    using the Options menu

2.    using the check boxes on the main window

In either case, the available options are as follows:

Map All Linked Documents
Select this option either by clicking this item from the Options menu, or by clicking on the 
corresponding check box on the main window.

If you select this option, HTML File Mapper will scan the Source Document and all linked documents 
during the mapping operation.    If this option is not selected, only the Source Document will be 
mapped.

Map Anchor Elements <A>
Select this option either by clicking this item from the Options menu, or by clicking on the 
corresponding check box on the main window.

If you select this option, HTML File Mapper will scan the specified documents for anchor (<A>) 
elements and will include the found elements in the mapping report.    If this option is not selected, 
anchor elements will be bypassed and not included in the mapping report.

Map Image Elements <IMG>
Select this option either by clicking this item from the Options menu, or by clicking on the 
corresponding check box on the main window.

If you select this option, HTML File Mapper will scan the specified documents for image (<IMG>) 
elements and will include the found elements in the mapping report.    If this option is not selected, 
image elements will be bypassed and not included in the mapping report.



Register

Opens a window that allows you to print a form for registering your use of the HTML File Mapper 
program.

When you print the form, any entries you have made in the Register window will automatically be printed 
on the form.    To print the form only, with no entries filled in, leave all entries in the Register window blank 
and click on the Print button.

Print Button
Click this button to print the registration form on your printer.    The window will be closed automatically.

Close Button
Click this button to close the Register window without printing the registration form on your printer.



Help 

Contents...

Runs Help and displays the Table of Contents

Search For Help On...

Displays Helps search dialog so you can quickly find the information you need.

How To Use Help

Displays the table of topics about how to use the Help system.

About...

Displays a window with the version, version number, and copyright notice for HTML File Mapper, along 
with information for contacting Sonshine Computing Services.    Click the Close button to close the 
About... window.



Making the Specifications

Select or specify the following information as needed and desired for mapping the html file(s).

Source Document
Enter the path and name of the html file to be mapped.    Alternatively, you may use the Browse button to 
select this file.

Browse... Button
Click this button to browse for the source document.    Clicking the Browse button has the same 
functionality as selecting Source Document from the File menu.

When you click this button, a dialog box opens that lets you select the source document file you want 
to open.

Dialog Box Options

File Name
Select or type the name of the user file you want to open.    By default, this box lists files with the 
filename extension, .HTM.    To see a list of files with a particular extension, type an asterisk (*), a 
period, and the three-character extension, and then press ENTER.    To see files with more than one 
filename extension, type a semicolon (;), a second asterisk (*), a period, and another three-character 
extension.    For example, if you want to see all files with the .HTM extension and all files with 
the .TXT extension, type *.htm;*.txt.

List Files Of Type
Select the type of file you want to see in the File Name list.

HTML Files (*.HTM)
Lists all files in the current directory that were saved with the .HTM extension.    This is the default.

All Files (*.*)
Lists all files in the current directory.

Directories
Select the directory that contains the file you want to open.

Drives
Select the drive that contains the file you want to open.

Read Only
Opens a file as read-only.

OK Button
To open the selected file, click the OK button.

Cancel Button
To cancel your selections, click the Cancel button.

Mapping Options
Select the mapping options you want by clicking the check box corresponding to the option you want to 
implement as follows:

Map All Linked Documents



If you select this option, HTML File Mapper will scan the Source Document and all linked documents 
during the mapping operation.    If this option is not selected, only the Source Document will be 
mapped.

Selecting this option is equivalent to choosing the Map All Linked Documents option from the Options 
menu.

Map Anchor Elements <A>
If you select this option, HTML File Mapper will scan the specified documents for anchor (<A>) 
elements and will include the found elements in the mapping report.    If this option is not selected, 
anchor elements will be bypassed and not included in the mapping report.

Selecting this option is equivalent to choosing the Map Anchor Elements <A> option from the Options 
menu.

Map Image Elements <IMG>
If you select this option, HTML File Mapper will scan the specified documents for image (<IMG>) 
elements and will include the found elements in the mapping report.    If this option is not selected, 
image elements will be bypassed and not included in the mapping report.

Selecting this option is equivalent to choosing the Map Image Elements <IMG> option from the 
Options menu.



How to Register

HTML File Mapper is distributed on a shareware basis.    If you use the unregistered version of HTML File 
Mapper for more than 30 days, you are expected to register.    When you register, you will receive the 
latest registered version of HTML File Mapper and will be recorded as a registered user.    You will also be
included on a mailing list for future versions of the program.

The registration fee is $29.00 including any tax, shipping, and handling fees.    The registration fee may be
charged to your American Express credit card.

To prepare your registration form, select the Register option from the main menu.    For detailed 
information about filling out and printing the registration form, go to Register.

You can also register through CompuServe and have your registration fee charged to your CompuServe 
bill.    Login to CompuServe, use the command GO SWREG, and follow the menus.    The registration ID 
for HTML File Mapper is 12001.

Advantages of Registering

In general, shareware provides one of a number of ways for distributing computer software in which the 
user is allowed to try before you buy.    By registering, you are supporting the shareware concept, and 
encouraging software developers to continue to make software available on this basis.

In particular, with respect to the HTML File Mapper program, you will receive a copy of the most recent 
version of the program when you register.    Available either on a 3.5-inch DSHD diskette or as an e-
mailed file, we will send you the latest program version upon receipt of your registration fee.    In addition, 
you will automatically receive information about subsequent versions and upgrades to the program.

Thank you for your support.



Information about HTML File Mapper

HTML File Mapper is a product of Sonshine Computing Services, Richard A. Eckhart proprietor.    The 
software is protected under U.S. and international copyright laws.

Sonshine Computing Services and Richard A. Eckhart may be contacted by E-mail using one of the 
following addresses:

CompuServe:    72425,525
The Internet:    72425.525@compuserve.com

You may also contact us via our homepage on the World Wide Web at:

http://ourworld.compuserve.com/homepages/reckhart

Technical Support

For technical support, contact us through one of the channels listed above.    Describe your problem as 
completely as possible, including a description of the operation you were performing when the problem 
was encountered, your system configuration, hardware, and software.    If you would like us to respond 
with a telephone call, please so state and be sure to give your telephone number and the preferred day 
and/or time you would like us to call.

Reporting Bugs

If you find a bug in HTML File Mapper, we would appreciate your informing us of the bug through one of 
the channels indicated above.    When you send us a bug report, please be as specific as possible 
including a description of the procedure for reproducing the bug and a description of your system 
configuration, hardware and software.

License Agreement

Disclaimer



A Brief Tutorial

Included with the files that were installed with the HTML File Mapper program are six files that illustrate 
how to use the program.    These files are:

SAMPLE.USR
This is a file containing user specifications for mapping SAMPLE_A.HTM and all linked 
documents.

SAMPLE.RPT
This is a report file that contains the mapping report for mapping SAMPLE_A.HTM and all of its 
linked documents.

SAMPLE_A.HTM, SAMPLE_B.HTM, SAMPLE_C.HTM, SAMPLE_D.HTM,
These are the html document files to be mapped.    It is assumed that SAMPLE_A.HTM is the 
original source document file, but any of the four files may be designated as the source.

These files are all text-formatted files, so you can view any of them with any standard text editor such 
as Notepad in Windows or with a word processor.

As a brief exercise to see how HTML File Mapper works, try the following steps:

1.    Select File...New from the menu bar, or click the New button on the Toolbar.

This will clear the Source Document entry box on the main window and set the three Mapping 
Options check boxes to checked.    Note that Report and Map on the menu bar are grayed, indicating 
that they are disabled at this time.

2.    Select File...Open from the menu bar, or click the Open button on the Toolbar.

This will open a dialog box from which you can select the file containing saved user specifications for 
doing an html file mapping.    In this exercise, use the dialog box to find file SAMPLE.USR.    This file 
will normally be found in the same directory where you installed the HTML File Mapper program (e.g.;
C:\HTML_MAP).

When you have found SAMPLE.USR using the dialog box, click the OK button to select the file.    The 
dialog box will close and the specifications will be displayed in the main window.

You can change any of the specifications as you wish

Note that Map on the menu bar has been enabled, while the Report menu item is still grayed to 
indicate that it is disabled.

3.    Select Map from the menu bar.

The HTML File Mapper program will execute, displaying a window showing the current html file being 
processed, until processing is complete.    The window will then close.

Note that Report on the menu bar has now been enabled.

4.    Select Report and then View from the menu bar, or click the View button on the Toolbar.

A frame will open displaying the report of the html file mapping results.    If the report is too long to fit 



entirely within the frame, a scroll bar will appear on the right side of the frame.    Use the scroll buttons
to scroll the report up or down.

To close the report frame, click anywhere outside the frame.

5.    To exit the program and return to Windows, select File...Exit from the menu bar.



An HTML container element used to create a link to another information resource or HTML document.    
The destination of the link is identified by the HREF attribute.



An HTML empty element used to include graphic images in an HTML document.    The source of the 
graphic image is identified by the SRC attribute.



Uniform Resource Locator:    comparable to a postal address, used to identify the location of documents 
on the World Wide Web. 



American Society for Computer Information Interchange:    a standard code for representing information in
a computer.



HyperText Markup Language:    a set of indicators (called elements) that define text and document objects
used in documents for the World Wide Web



Shareware: A software marketing channel for computer software products which lets the buyer try the 
product for a limited time period before paying for it.



Glossary

Term Definition
Anchor <A> An HTML container element used to 

create a link to another information 
resource or HTML document.    The 
destination of the link is identified by the 
HREF attribute.

ASCII American Society for Computer 
Information Interchange:    a 
standard code for representing 
information in a computer.

html HyperText Markup Language:    a set 
of indicators (called elements) that 
define text and document objects 
used in documents for the World 
Wide Web.

Image <IMG> An HTML empty element used to include 
graphic images in an HTML document.    
The source of the graphic image is 
identified by the SRC attribute.

Shareware A software marketing channel for 
computer software products that lets
the buyer try the product for a 
limited time period before paying for
it.

URL Uniform Resource Locator:    
comparable to a postal address, 
used to identify the location of 
documents on the World Wide Web.




